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Scheduler Overview 

Purpose 

Scheduler is a common system that allows multiple schedulers in different areas to 

create, maintain, and view schedules for their area. Workforce Scheduler also allows a 

Staffing Office and Schedulers to review the staffing levels for each shift and make 

adjustments as necessary. Employees can make requests that can impact the 

schedule. 

Phases of Scheduling 

 

Staffing Requirements (Workload Planner) 

In order to schedule the correct number of employees in a location, you need to know 

the required staffing levels for each job. The number of employees required can be 

different for each location. In some locations, the staffing requirements may be based 

on census and acuity while the staffing requirement for other locations might be based 

on the number of tests they need to perform. This is called the workload. The workload 

is defined for each job in a location for a specified time span.  

 

Job Time 
period 

Sun Mon Tues Wed Thurs Fri Sat 

RN 0700-
1500 

3 3 3 3 3 3 3 

1500-
1900 

3 3 3 3 3 3 3 

1900-
2300 

2 2 2 2 2 2 2 

2300-
0700 

2 2 2 2 2 2 2 

 

  

Estimate 
Staffing 

Requirements

Create 
Schedules

Evaluate 
Schedules

Post and 
Maintain 
Schedules
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Scheduling Strategies 

Scheduling strategies and processes vary depending on the needs of the department. 

In some departments, employees may enter their shift preferences while in other 

departments; the employees’ schedules may be solely created by the scheduler. Some 

employees’ schedules change each week, while other employees’ schedules rarely 

change.  

If an employee generally works the same schedule each week, you can schedule the 

employee using a pattern. Some patterns are already created and saved in Scheduler. 

This is called a pattern template. If the employee works different days and times each 

week, you can schedule the employee as needed by entering the shift start and end 

times.  

 

Employee Job Scheduling 
Strategy 

Week Sun Mon Tues Wed Thurs Fri Sat 

 

MA Add a 
pattern 
template 

Week 1  0630-
1500 

0630-
1500 

0630-
1500 

0630-
1500 

  

Week 2  0630-
1500 

0630-
1500 

0630-
1500 

0630-
1500 

  

 

RN Add a 
pattern 

Week 1 0645-
1915 

0645-
1915 

 0645-
1915 

   

Week 2  0645-
1915 

0645-
1915 

  0645-
1915 

 

 

RN Enter a 
schedule as 
needed 

Week 1 0645-
1915 

   0645-
1915 

  

Week 2  0645-
1915 

 0645-
1915 
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Evaluating the Schedule 

Scheduler analyzes how many employees are scheduled to work in a specified time 

span and compares that number to the workload. Schedules can be viewed and 

adjusted for appropriate coverage at any point in the process. 

 

Employee Job Week Sun Mon Tues Wed Thurs Fri Sat 

 

RN Week 1   0645-
1915 

0645-
1915 

0645-
1915 

  

 

RN Week 1 0645-
1915 

0645-
1915 

 0645-
1915 

0645-
1915 

  

 

RN Week 1 0645-
1915 

   0645-
1915 

0645-
1915 

 

 

RN Week 1  0645-
1915 

0645-
1915 

  0645-
1915 

 

 

RN Week 1 0645-
1915 

   0645-
1915 

 0645-
1915 

 

RN Week 1    0645-
1915 

 0645-
1915 

0645-
1915 

Total RN’s 
for 0700-

1500 Zone 

  3 2 2 3 4 3 2 

Workload    3 3 3 3 3 3 3 

Coverage 
  Fully 

staffed 
Under 
staffed 
by 1 

Under 
staffed 
by 1 

Fully 
staffed 

Over 
staffed 
by 1 

Fully 
staffed 

Under 
staffed 
by 1 
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In addition to coverage, Scheduler also analyzes the employee’s schedule for violations 

of organizational policies. The violations can be at the employee level. For example, 

employees that are scheduled for more than forty hours in a week can have a violation. 

The violations can also be at the location level. For example, a location has to have a 

Charge Nurse for each shift. 

 

Employee Job Skills Sun Mon Tues Wed Thurs Fri Sat 

 

Sally 

RN Charge  0645-
1915 

0645-
1915 

 0645-
1915 

  

 

Joan 

RN Charge 0645-
1915 

    0645-
1915 

0645-
1915 

 

Sara 

RN  0645-
1915 

0645-
1915 

 0645-
1915 

0645-
1915 

  

Location 
Violation 

     No 
Charge 
Nurse 
for the 
shift  

   

Employee 
Violation 

  Sara is 
over 
40 
hours 
in a 
week 
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Scheduling Building Blocks 

Once you decide on a scheduling strategy, Scheduler has a number of tools to help you 

create your employees’ schedules. These tools also help you maintain accurate 

schedules when an employee deviates from his or her schedule. Use the following table 

to assist you in scheduling employees. These tools are available in the Scheduler. 

 

Tool Description Possible Use 

Pattern Template Used to create an employee’s schedule 
using a predefined pattern of days and 
shifts. A pattern can repeat forever or can 
have an end date. A pattern assignment is 
the method used to define the employee’s 
standard schedule. 

Create a schedule for a new 
hire to work Monday through 
Friday from 7:00AM to 3:30PM. 

Pattern Editor Used to create an employee’s schedule for 
selected days and shifts; unlike pattern 
templates they are not predefined. A 
pattern can repeat forever or can have an 
end date. A pattern assignment is the 
method used to define the employee’s 
standard schedule. 

Create a schedule for an 
employee that works every 
other Saturday. 

Shift Template Used to update an employee’s schedule 
by adding a pre-defined start and end time 
to a day they are expected to be at work. 

Add an additional shift to one or 
more employee’s schedule to 
work on Sunday. 

Pay Code Edits Used to add non-worked time to a 
schedule. 

Replace an employee’s shift 
with Jury Duty. 

Schedule Quick Actions Contains short cut icons to various 
scheduling building blocks. 

Add the same shift to several 
employees’ schedules. 

Self-Schedule Used by employees to select shifts, 
request open shifts, and shift swaps. 

Employee selects a shift to 
work, or requests a day off. 

Staffing Widget Gives you quick access to your daily 
staffing plan. 

Make adjustments when 
unforeseen events occur. I.E. 
Call In, Census Change, etc. 
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Logging On – Single Sign-On  

Purpose 

Workforce Central is accessed via the Expressway in Manager/Employee Self-Service. 

There is no additional ID/password needed for Kronos Workforce Central where you to 

perform your time and attendance tasks. 

Example 

You, as the department Manager, log on to the Workforce Timekeeper application at 

least once a day to review and work with your employees’ timecards and scheduling 

data. 

 

Steps 

1 Access the Employee and Manager Self-Service log in page. 

2 Enter your user name and password in their designated fields. 

3 Click the WFC - Kronos link in the Expressway. 

 

 

 

Business practice 

If you or an employee using Kronos forgets your Employee and Manager Self Service user 
name or password, contact the IT Help Desk at 248-853-4900. 
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Logging Off  

Upon completion of your tasks, you must log off Kronos to ensure that your employees’ information is 

kept confidential. 

 

 

 

Caution 

Clicking the Close (X) button without first logging off might leave your connection to Kronos 
open, making it possible for unauthorized people to view and edit information. 

 

Timing Out 

If Kronos doesn’t detect activity within a specific amount of time, it will automatically 

“time out” to protect sensitive information. Shortly before the system times out, you will 

be prompted to click Yes to continue working or No to log out. 

 

 

Caution 

If you select No or the system times out, you will lose any unsaved changes. 

 

 
Business practice 

The inactivity timeout screen appears if there is no activity for 29 minutes. 
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Navigating Kronos 

Navigating 

The key areas of Kronos 

Tabs at the top refer to a workspace. A workspace contains a set of tools related to a 

certain aspect of your job. Additional workspaces can be displayed in the workspace 

carousel. Within a workspace are widgets. A widget contains information and/or 

functionality for you to perform tasks in Kronos.  

The Genies widget displays by default in the Manage My Department workspace.  The 

name of the Genie reflects a common task, such as Reconcile Timecard 

Additional widgets are stored in the Workspace’s Related Items pane. Select a widget 

for it to display as its own tab. Click the X in the tab to close it. The default workspace, 

Manage My Department, cannot be closed.  

Collapse the Related Items pane for additional real-estate by clicking its arrow. Hover 

over any item to display its name  

Refresh any workspace by clicking the double arrows... 
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Using the New Workspace Menu 

You can navigate to additional workspaces using the New Workspace Menu. When you click the + (plus 

sign) tab, available workspaces display. Click one to open it.  

 

Use the X in the tab of a workspace to close it. 
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Using the Tools within the Workspace 

The Show box (unlabeled) allows you to display a group of employees. When you log 

on, the default setting for the Show box is All Home, which displays all employees in 

your cost center(s). You can use the Show box to refine your selection further to include 

employees in a specific group, such as only those employees who work in a particular 

area or on a particular shift. 

The Time Period box (unlabeled) allows you to specify the timeframe you want to view, 

such as the current pay period or a particular timeframe in the past, present, or future. 

The time period you select controls what you will see on that page. 

 

Refresh, Share, and GoTo buttons are located at the top right of most workspaces.  Use 

the Share button to print or export the current workspace to Excel.  

Use the GoTo button to access information specific to one or more employees. For 

example, you can select one employee and click the Timecard item in the GoTo list. to 

access his or her timecard. Or, you can select multiple employees and click the 

Schedule item in the GoTo list to view schedules for just those employees whom you 

selected. 
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On Your Own – Structured Practice – Navigating Kronos 

• Click the Refresh button in the Workspace tab 

• Click the New Workspace Menu carousel 

• Select the Scheduling Manager item 

• Collapse the Related Items pane 

• Hover over the 2nd item and read the name 

• Expand the Related Items pane 

• Select the Staffing Widget item in the Related Items pane 

• Close the Staffing Widget workspace 

• Set the Time Period box to Next Schedule Period 

• Set the Show box to All Home Locations 

• Click the Quick Actions button (displays additional action buttons) 

• Read the names of the Quick Actions buttons 

• Click the Quick Actions button (hides additional action buttons) 

• Sign Out of Kronos 

 

 

  



 Kronos 8.1 Advanced Scheduler Course Guide v.4 

 

14 © 2019, HFHS University. All rights reserved. 
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Schedule Build Processes 

Scheduling Process with Self Scheduling 

Purpose 

The following list describes the scheduling process for departments that self-schedule: 

1. Pre-schedule tasks completed.  These are typically one-time tasks: 

Unique selection locations created, if necessary 

Employees assigned to group(s), if necessary 

2. Patterns, if used, are entered in the schedule 

3. Individual shifts for individual employees are entered in the schedule if patterns 

are not used.  

4. Non-standard events such as orientation, education, jury, funeral, , or on-call 

time are entered in the schedule 

5. Self-scheduling is opened 

6. (Optional) Schedules are locked and unlock to allow for self-schedule in groups 

7. Self-scheduling is closed 

8. Schedule is evaluated for rule violations and coverage 

9. Schedule is balanced 

10. Schedule is posted 

 

Scheduling Process without Self-Scheduling 

Purpose 

The following list describes the scheduling process for departments that do not self-schedule: 

1. Pre-schedule tasks completed.  These are typically one-time tasks: 

Unique selection locations created, if necessary 

Employees assigned to group(s), if necessary 

2. Patterns, if used, are entered in the schedule. 

3. Individual shifts for individual employees are entered in the schedule if patterns 

are not used.  

4. Non-standard events such as jury, training, orientation, or on-call time are 

entered in the schedule 
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5. Schedule is evaluated for rule violations and coverage 

6. Schedule is balanced 

7. Schedule is posted 
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Setup Tasks 

Navigating the Scheduler Widget 

Purpose 

The Scheduler widget is the primary tool for creating and managing upcoming 

schedules. 

The key components the Scheduler 
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Adjusting the Schedule Planner View 

Purpose 

You have the following options for manipulating how data appears in the Schedule 

Planner: 

• Sort the data by certain columns; for example, by the Job column 

• Resize areas of the workspace 

• Use options in the View menu to change time intervals, show shift times or shift labels, and show 
and hide data 

• Use the Schedule Planner top tabs for different views of schedule data and employees: By 
Employee, By Group, and By Job 

• View additional data about employees in tool tips 

• Zoom in and out on date columns in the schedule grid area 

Example 

You want to review schedules for the next schedule period to locate RN’s with the 

fewest scheduled hours. To easily see the data you want, sort employees by Scheduled 

Totals and Job. 

Feature Description 

Sorting and 
Displaying columns 

 

Every column header has a drop down menu to sort by that item and to select the visible 
columns. An arrow appears in the column header to indicate that the column is sorted. Click on 
the column header again to reverse the sort. 
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Feature Description 

Resizing 
workspaces 

You can resize individual workspaces in the Schedule Planner to see more or less of the 
information they contain. For example, you can move the divider between the employee rows 
and bottom tabs up or down to display more or fewer employee rows. 

 

Using Visibility 
Filter options 

Use the options in the Visibility Filter menu to adjust how data appears in the Scheduler, 
including: 

• Whether shift labels or shift times appear 

• Whether and How pay codes appear 

• Whether several items appear (see image below) 

 



 Kronos 8.1 Advanced Scheduler Course Guide v.4 

 

20 © 2019, HFHS University. All rights reserved. 

Feature Description 

Using the View 
drop down menu 

Use this menu to display schedule data by employee, by group, by employment terms, or by 
job. 

 

Tool tips Use tool tips to display data about scheduled employees and shifts. 
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Feature Description 

Zoom Click any week column header to view that week only.  

Click and day column header to view that day only.  

Click any week day column header to toggle back. 

Before 

 

 

After 
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Saving a Personal Location (Search Query) 

Purpose 

For employees in departments and jobs that you view frequently, you can save a set of 

locations or jobs as a reusable query that appears in the Show drop-down list. Personal 

location queries are not the same as HyperFind queries; they relate only to locations 

and jobs in an organizational map. 

 

 

Note 

The All Home Locations query DOES let you evaluate coverage, review rule violations, or 
view open shifts. 

 

The All Home hyperfind limits Workforce Scheduler functionality. For example, it DOES NOT 
let you evaluate coverage, review rule violations, or view open shifts. 

Example 

You need to frequently work schedules for nurses in Department 3M4132. A custom 

location makes this task easier. 

Steps 

1 Access the Scheduler. 

 

2 From the Location drop-down list, 
choose Select Locations. The 
Select Locations dialog box 
appears and all locations that you 
have access to are selected by 
default. 
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Steps 

3 Expand the organizational map by 
clicking the plus (+) signs until the 
appropriate locations and/or jobs 
appear. Select the job and use the 
arrow to move to the “Selected” 
box. 

 

5 Click Save As. 

Enter a name. 

Click Save 

 

 The Scheduler displays scheduling 
data for the selected employees 
and time period. 

 

Note:  Use the Edit button to Delete an existing location. 

 

 

Practice: 

1. Create and save a new location for NAs in 3M4132 

2. Create and save a new location RNs in 3M4271. 

3. Create and save a new location RNs in 3M3400. 

4. Create and save a new location that displays all RN’s regardless of which 

department.  
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Assigning Schedules Groups 

Purpose 

A schedule group is a collection of employees who work the same or similar shifts. You 

assign employees to schedule groups to facilitate creating and editing their schedules. 

Employees can be assigned to more than one schedule group. 

Example 

When evaluating and building your schedule, you find it helpful to view employees by 

their preferred shifts and jobs. You group your employees by assigning them to their 

preferred times. A new employee prefers to work days. You assign her to the 2-Day 

schedule group. 

Steps 

1 Access a Scheduler.  

2 Select the specific set of 
employees and the specific time 
period. 

 

3 Select the By Schedule Group 
from the View button. 

 

4 Do one of the following: 

• Right-click the employee 
that you want to assign to 
a schedule group.  

• Select multiple employees 
by holding the Ctrl key 
and single-clicking each 
employee’s name. Then 
right-click one of the 
selected employees 

 

5 Select Add to Group.  
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Steps 

6 From the Schedule Group drop-
down list, select the name of the 
schedule group to which you want 
to assign to the employee(s). 

 

7 From the Start Date drop-down 
calendar, select the effective date 
for the schedule group assignment. 

8 From the End Date drop-down 
calendar, select one of the 
following: 

• Last date the schedule 
group assignment will be 
in effect. 

• Forever for the 
assignment to be in effect 
with no end date. 

9 Click Apply. 

10 Click Save. 

 

 

 

 

Business practice 

Contact Employee Services at: 

employeeservices@hfhs.org or 855-874-4100 to have a new schedule group created.  

 

 

mailto:Kronos@company.com
mailto:employeeservices@hfhs.org
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Tip 

To remove an employee from a schedule group, repeat steps 1 – 4.  Then select Remove 
from Group. Select the schedule group from which you are removing the employee and the 
start and end dates during which the employee will no longer be a member of the group. To 
remove the employee from the schedule group indefinitely, select Forever. 
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Shift Times vs. Shift Labels 

Purpose 

Scheduled shifts are displayed using one of two different formats: 

• Shift Times:  Start Time through End Time (i.e. 7a-730p) 

• Shift Labels: A pre-defined code that represents the length of a shift and when it 

starts. 

The Scheduler display Shift Labels by default.  Use the Visibility Filter button to display 

Shift Times. 

Shift Label Examples 

First Character 
(Abbreviation) 

Shift Duration 
Shift Label 
Example 

Shift Time 

A 12 Hour (12A-12P) A5 5a-530p 

P 12 Hour Night (12P-12A) P5 5p-530a 

D 8 Hour Day (5A-3P) D7 7a-330p 

E 8 Hour Eve (3P-11P) E3 3p-1130p 

N 8 Hour Night (11P-7A) N11 11p-730a 

B 2 Hours B11a 11a-1p 

C 3 Hours C7p 7p-10p 

F 4 Hours F6p 6p-10p 

V 5 Hours V1130a 1130a-430p 

S 6 Hours S7a 7a-130p 

L 7 Hours L9a 9a-430p 

R 9 Hours R7a 7a-430p 

T 10 Hours T7a 7a-530p 

H 11 Hours H530a 530a-5p 

K 13 Hours K2a 2a-3p 

Y 14 Hours Y5p 5p-730a 

W 15 Hours W330p 330p-7a 

G 16 Hours G330p 330p-8a 

J 17 Hours J630a 630a-1130p 

Z 24 Hours Z6pnl 6p-6p 
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Creating Schedules Using Pattern Templates 

Purpose 

Schedule patterns let you quickly apply a set of shifts to employees who work the same 

shifts on a regular basis. A schedule pattern consists of one or more shifts that repeat 

over a specified time period. When you create schedules for employees who have a 

schedule pattern, you can add the shift days and times manually or use a predefined 

pattern template. The pattern template defines the pattern of the shifts’ days and times 

and makes it easier and faster for you to create the employees’ schedules. 

Example 

You want to schedule an employee to work 8:00 A.M. to 4:30 P.M. Monday through Friday every week, 

starting Sunday of the next schedule period. You know that a pattern template exists that defines this 

schedule pattern, so you will use it because it is easier and faster than adding the schedule manually. 

Steps 

1 Access the Schedule. 

 

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period drop-
down list. 

3 Right-Click the name of the 
employee who you will schedule 
using a pattern template.  

4 Select Schedule Pattern. 

 

Define the following terms: 

Shift:    

 

Pattern:    

 

Template:     
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Steps 

5 Click Pattern Template. 

 

6 Select a pattern from the list. 

 

7 From the Start Date calendar icon, 
specify the date on which the 
employee(s) starts working the 
pattern. 

 

8 From the Anchor Start calendar 
icon, specify the date on which the 
pattern starts. 

9 From the End Date calendar icon, 
specify the last date that the 
pattern will be effective. To have 
the pattern in effect with no end 
date, select Forever. 

10 Click Apple and then click OK. 

 

11 Click Save. 

 

 

 

Business practice 

Always look for a pattern template first when scheduling employees with schedule patterns. If a 
pattern template is not available, contact your administrator. 
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Creating Schedule Patterns without Pattern Templates 

Purpose 

If a pattern template does not exist, you can create a schedule pattern manually and 

apply it to one or more employees as you create it. The application, however, does not 

save the schedule pattern as a pattern template, so you cannot assign it to employees 

later. You would need to create it again manually. 

Example 

One of your employees is scheduled to work Monday, Wednesday, and Friday from 11:00 P.M. to 7:30 

A.M. Even though there is no pattern template for this schedule, you know that it is quicker to create the 

schedule using a schedule pattern than to schedule each day separately.  

Steps 

1 Access the Schedule.  

 

2 Select the specific set of employees 
from the Show drop-down list. 
Select the specific time period from 
the Time Period drop-down list. 

3 Right-Click the name of the 
employee who you will schedule 
using an ad-hoc pattern. 

4 Select Schedule Pattern. 

 

5 Set the Define Pattern for field to 
the correct interval, for example, 
days or weeks, and the number of 
days or weeks the pattern repeats. 

 

6 Click the cell of the each day that 
applies to the schedule pattern. To 
select multiple days hold the Ctrl 
key and click the appropriate cells.  

7 Click Shift Template. 

 

8 Select the appropriate shift.  Use the 
Search box to shorten the list.  
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9 From the Anchor Date calendar 
icon, specify the date when the 
pattern starts. Note: this should be 
a Sunday. 

 

10 From the Start Date calendar icon, 
specify the date when the 
employee(s) starts working the 
pattern.  Note: this should be a 
Sunday.  

11 From the End Date calendar icon, 
specify the last date that the pattern 
is effective. To have the 
assignment in effect with no end 
date, select Forever. 

12 (Optional) To replace all other 
assigned schedule patterns with the 
new schedule pattern, select the 
Override other patterns check box. 

13 Click Apply, OK and then click Save. 
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Updating Schedule Patterns 

Purpose 

From time to time, employees’ regular schedule patterns might change for reasons such 

as workload changes, status changes, or terminations. When you need to change an 

employee’s schedule pattern, you can override the existing pattern(s) to adjust for the 

changed circumstances.  

Example 

An employee will now be working 3:00 P.M to 11:30 P.M. on Monday - Friday. You 

assign the new pattern and override the old pattern as of the 2nd Monday of the next 

schedule period. 

Steps 

1 Access the Schedule. 

 

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period drop-
down list 

3 Right-Click the name of the 
employee whose schedule pattern 
is changing and choose Schedule 
Pattern. 

4 Select Add Pattern 

5 From the Anchor Date calendar 
icon, specify the date when the 
employee(s) starts using the new 
schedule pattern. Note: this should 
be a Sunday. 

 

6 From the Start Date calendar icon, 
specify the date when the new 
schedule pattern starts.  Note: this 
should be a Sunday.  

7 From the End Date calendar icon, 
specify the last date that the 
pattern is effective. To have the 
assignment in effect with no end 
date, select Forever. 

8 Select the Override other 
patterns check box. 
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Steps 

6 Use one of the following options to 
enter the new shift pattern: 

• Enter the shift start and end 
times in each applicable cell. 

• Click the applicable cells, click 
Shift Template and select the 
shift template. 

• Click the applicable cells, click 
Add Shift, define the shift 
attributes, and click Apply. 

• Click Pattern Template and 
select the pattern. 

 

7 Click Apply. 

8 Click Yes when you see the 
message about Confirming 
‘Override.’ 

 

9 Click OK.  

Then click Save. 

 

 

 

 

Tip 

To update a pattern, it’s easiest to follow the steps as if you were going to assign a new 
pattern and select the Override other patterns check box. The old pattern will be overridden 
as of the new work start date. 

To end an employee’s pattern without replacing it with a new pattern, right-click on the 
employee’s name and select Schedule Pattern. Use the Pencil Icon next to the pattern that is 
ending to edit that pattern. Select End Date and enter the last date the pattern will be active. 
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Adding/Editing Shifts with (Full Day) Transfers 

Purpose 

Each employee is assigned a primary labor account and default work rule. During the 

normal workday, all worked and non-worked hours are charged to this assigned labor 

account. Occasionally, you may need to transfer the employee to another labor account 

or work rule. You need to record the transfer in the application so that the right labor 

account is charged and the right work rule is applied.  Transfers can be made when 

either adding a new shift or editing an existing shift. 

Example 

On Wednesday of the next schedule period, you need an employee to work her entire shift in a different 

cost center. Schedule the employee to work in the other cost center from 7:30 A.M. to 4:00 P.M. on 

Wednesday of the next schedule period. 

Steps 

1 Access the Schedule. 

 

2 Select the specific set of 
employees from the Show drop-
down list. Select the specific time 
period from the Time Period drop-
down list. 

3 Right-Click the employee’s cell in 
the row and below the date where 
you want to add/edit a shift that 
requires a transfer.   

4 Select Edit when changing the 
transfer settings of an existing shift. 

 

Select:  Add Shift when adding a 
new shift that is a transfer. 

 

5 In the Edit Shift window: 
Confirm/enter the correct date in 
the Start Date field. 
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6 From the Type drop-down list, 
select the Transfer shift type. 

 

7 In the Start Time field, 
confirm/enter the time the shift 
starts and press Tab. 

8 In the End Time field, 
confirm/enter the time the shift 
ends and press Tab. 

9 Confirm/enter the correct date in the 
End Date field. If the shift crosses a 
day divide, change the shift’s end 
date to the following day. 

10 What kind of transfer(s) do you 
want to perform? 

 

 

• Transfer hours to another labor 
account (i.e. Cost Center):  
Click the Labor Level Transfer 
drop-down list and select 
Search.  

• Enter a value in the appropriate 
Transfer level field or select a 
value from the level drop-down 
list.  

• Then click Apply. 

(Note:  Job Transfer is utilized by 
Advanced Scheduling units, 
typically inpatient nursing.) 
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 • Transfer hours to another work 
rule (i.e. Charge Nurse, 
Preceptor, Orientation, OnCall 
etc.): 

• Click the Work Rule Transfer 
drop-down list and select the 
appropriate value.(See Prefixes 
below).. 

 

11 Click Apply.  

12 (Optional) In the Repeat this shift 
for [blank] days field, enter the 
number of consecutive days that 
you want the transfer to last.  

13 Click Save  

 

 

Visual Indicator Definition 

(x) Labor account transfer associated with a shift  

(work rule) Work rule transfer associated with that shift 

 

Prefixes to Alternate Work Rules 

 
                         EX UP30                       Exempt, unpaid 30 min lunch 

                         NEMS                           Non –exempt, Market Sensitive, Inpatient Nurse 

                         NENSNW                     Non-exempt, No shift, No weekend 

                         NE                                 Non-exempt, with weekend/shift premiums                    

                         NENS                            Non-exempt, No shift 
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Adding Shifts with (Partial Day) Transfers 

Purpose 

Each employee is assigned a primary labor account and default work rule. During the 

normal workday, all worked and non-worked hours are charged to this assigned labor 

account. Occasionally, you may need to transfer an employee to another labor account 

or work rule for part of his or her shift. You need to note the transfer in the application so 

that the right labor account is charged and the right work rule is applied. Transfers can 

be made when either adding a new shift or editing an existing shift. 

Example 

You need to schedule an employee to work hours in two different cost centers on Friday of the next 

schedule period. You want the employee to work in her home cost center from 8:00 A.M. to 11:00 A.M. 

and then the other cost center from 11:00 A.M. to 4:30 P.M. Schedule an employee to work part of her 

shift (from 8:00 A.M. to 11:00 A.M.) in her home cost center and then the remainder of her shift (from 

11:00 A.M. to 4:30 P.M.) in the other cost center on Friday of the next schedule period. 

Steps 

1 Access the Schedule.  

 

2 Select the specific set of 
employees from the Show drop-
down list. Select the desired time 
period from the Time Period drop-
down list. 

3 Right-Click the employee’s cell in 
the row and below the date where 
you want to add/edit a shift that 
requires a transfer.   

4 Select Add Shift. 

 

5 In the Edit Shift window, confirm 
the correct date in the Start Date 
field. 

 

6 For the hours that the employee is 
scheduled to work before the 
transfer, fill in the Start Time and 
the End Time fields. 

7 Click the Insert Row icon. 
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Steps 

8 From the Type drop-down list, 
select the Transfer shift type. 

 
9 In the Start Time field, confirm the 

time that the shift transfer begins 
and press Tab. 

 

10 In the End Time field, enter the 
time that the shift transfer ends and 
press Tab. 

11 Confirm that the date in the End 
Date field is correct. If the shift 
crosses the day divide, change the 
shift’s end date to the following 
day. 
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Steps 

12 What kind of transfer(s) do you 
want to perform? 

• Transfer hours to another labor 
account (i.e. Cost Center):  
Click the Labor Level Transfer 
drop-down list and select a value 
from the list or select Search.  

• Enter a value in the appropriate 
Transfer level field or select a 
value from the level drop-down 
list.  

• Then click Apply. 

(Note:  Job Transfer is utilized by 
Advanced Scheduling units, 
typically inpatient nursing.) 

 

 

 • Transfer hours to another work 
rule (i.e. Charge Nurse, 
Preceptor, Orientation, OnCall 
etc.): 

• Click the Work Rule Transfer 
drop-down list and select the 
appropriate value. 
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Steps 

15 If the employee is scheduled to 
work hours after the scheduled 
shift transfer, click the Insert Row 
icon and select the correct type 
from the Type drop-down list. 

 

16 In the End Time field, enter the time 
that the shift ends and press Tab. 

17 (Optional) In the Repeat this shift 
for [blank] days field, enter the 
number of consecutive days that 
you want the transfer to last. 

 

13 Click Apply.  

18 Click Save.  
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Editing Scheduled Shifts 

Purpose 

When events in employees’ lives require them to take time off and when your workload 

requirements vary, you will need to change employees’ schedules. You need to keep 

the schedules accurate to reduce the number of exceptions that might appear in 

employee timecards. 

Example 

Your workload requirements have changed on Wednesday of the next schedule period, so that you need 

to change an employee’s schedule to satisfy the new requirements. 

Steps 

1 Access the Schedule.  

2 Select the specific set of 
employees from the Show drop-
down list. Select the time period 
from the Time Period drop-down 
list. 

 

3 Locate the employee’s row and 
click the cell in the row and below 
the date that contains the shift that 
you want to edit. 

 4 Edit shift start and/or end times 
and press Tab. 

5 Click Save. 
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Deleting Shifts from Employees’ Schedules 

Purpose 

Employees sometimes are unable to work a scheduled shift. When this happens, you 

need to delete the shift from the employee’s schedule to prevent the application from 

flagging the employee as absent without an excuse. 

Example 

An employee mentioned that she will be unable to work Friday of the next schedule period because she 

needs to attend her brother’s funeral. Access the Schedule and delete the employee’s schedule for Friday 

of the next schedule period. 

Steps 

1 Access the Schedule.   

2 Select the specific set of 
employees from the Show drop-
down list. Select the time period 
from the Time Period drop-down 
list. 

 

3 Click the Quick Actions button 
and select the Delete button. 

 

 

4 Locate the employee’s row and 
click the cell in the row and below 
the date that contains the shift you 
want delete. 

 

5 Click Save. 
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Restoring Deleted Shifts 

Purpose 

If an employee’s plans change or a shift was deleted in error, you can restore the shift if 

it belongs to a pattern. Use the Restore feature on the Right-Click menu to insert the 

original shift into the employee’s schedule. 

Example 

An employee’s plans have changed so she will be able to work the Friday of the next schedule period 

after all. Access the Schedule Editor and restore the shift in the employee’s schedule for Friday of the 

next schedule period. 

Steps 

1 Access the Schedule.   

2 Select the specific set of 
employees from the Show drop-
down list. Select the time period 
from the Time Period drop-down 
list. 

 

3 Locate the employee’s row and 
click the cell in the row and below 
the date where you want to restore 
the shift. 

 

4 Select Restore. 

5 Click Save. 
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Using Online Help 

Purpose 

Kronos contains a link to the HFHS Kronos Support Page to help you perform 

scheduling tasks. It contains tip sheets and other resources.  

Kronos Support Page 

Steps  

1 Use the Carousel to open the My 
Information Manager workspace. 

 

2 Select Kronos Support Page from 
the Related Items list on the right. 
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Kronos Support Page on OneHENRY 

Steps  

1 Navigate to the HR Connect page. 

Click the Information on Kronos 
link.  
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Pre-Schedule Build 

Managing Employee Request Periods for Time-Off  

Purpose 

To allow employees to submit time-off requests in self-service, a request period must be 

opened. An Employee Request Period defines who can submit a time-off request, when 

the employee can submit a request, and the dates that can be requested off.  

 

 

Business practice 

By default, a universal Time-off request period is left open to allow employees 

to submit a time-off request for any time period. 

 

Employee Request 
Periods 

Description 

Name Name of the employee request period. 

Request For Type of request. 

Description Description of the request. 

Employee Query HyperFind query that identifies the employees who can make a request. 

Submission Start and 
Submission End 

Beginning and ending dates and times that define the time period during which 
employees can submit requests. 

This option can also be set to Any Time for unlimited request submissions. 

Request Start and 
Request End 

Beginning and ending dates and times, which define the time period for which 
employees can make requests. 

This option can also be set to Any Date for unlimited request submissions. 

State Status of the request period. 
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Example 

You want to open a time off request period so that employees in can submit requests for 

the next schedule period. 

 

Steps 

1 Access a Scheduler.  

2 Select Tools > Manage Employee 
Request Periods.  

The Manage Employee Request 
Periods window displays. 

 

3 Do one of the following: 

• If an employee request 
period does not exist, 
click Add Request 
Period. 

• If an employee request 
period exists, select the 
Pencil Icon of the period 
to edit.  

 

4 In the Name field, enter a 
descriptive name. In the 
Description field, enter 
explanatory text about the 
employee request period. 

Note: An employee request period 
must have a unique name. 

 

5 From the Request For drop-down 
list, select the request type. 

6 From the Employee Query drop-
down list, select the specific set of 
employees who will be entering 
requests not to be scheduled. 
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Steps 

7 In the Submission Period area, 
select one of the following: 

• Specific Start Date and 
Time and End Date and 
Time to identify a specific 
timeframe when 
employees can submit 
requests. 

• Any Time to allow 
employees to submit 
requests any time without 
restrictions. 

8 In the Request Period area, select 
one of the following: 

• Specific Start Date and 
End Date to identify the 
timeframe that the 
employee can request to 
be off of work. 

• Any Date to allow the 
employee to request to be 
off of work on any date.  

9 Click Save. 
 

 

 

 

 

Business practice 

Time-off requests can be submitted online or via the Kronos terminal (clock). Regardless of 
which method is used by the employee, the approval process is the same.  

 
Business practice 

Because Scheduler does not limit employees to the number of requests they can submit, you 
will need to tell your employees how many requests they can submit.  
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Responding to Time-Off Requests 

Purpose 

The Requests widget summarizes all employees’ requests in one window and provides all supporting 

information to process requests from the same screen. If you approve a request, the change is 

automatically made to the schedule and the employee is notified automatically. If you reject a request, the 

employee is notified automatically.  

Example 

An employee submitted a time-off request. You want to review and respond to the 

request. 

Steps 

1 Select the Requests Widget tab. 

 

2 From the Request Widget, select 
View All.  

 

 

3 From the Alerts and Notifications 
Widget, select a request. 

 

4 From the Requests widget, select 
a request and click the appropriate 
button to take action. Details of the 
request appear at the bottom of the 
page.  Accruals for the employee 
are also visible at the bottom of the 
page.  
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Replacing a Shift with a Pay Code  

Purpose 

Frequently, a scheduled shift needs to be replaced with a pay code edit, such as when 

an employee scheduled to work is called for jury duty or has a death in the family. The 

Quick Actions Toolbar includes a button to perform pay code edits that replace shifts 

with minimum clicks. 

Example 

Employee is scheduled to work this Friday but will be using a funeral day. You want to 

schedule the funeral time as a pay code edit. You know that you will need to create an 

open shift to find a replacement for the employee, so you use the Quick Actions 

Toolbar’s Pay Code button. 

Steps 

1 On the Quick Actions Toolbar, 
click the Pay Code button, roll over 
a list, and select the appropriate 
pay code to apply. 

Tip: Use the Search box for a 
shorter list. 

 

 

2 Click the date cell of the shift you 
want to replace with the pay code 
edit. 

 

3 (Optional) Click additional date 
cells to replace the shifts with the 
selected pay code. 

4 Click Save. 

Note: If you want to make other 
edits to the schedule before 
saving, be sure to click the Pay 
Code button again to turn it off. 

 

 

 

Tip 

When you use the Quick Actions Pay Code button, Scheduler automatically creates an open 
shift.  
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Building a Schedule: Managing Self-Scheduling 

Managing Employee Request Periods for Self-Scheduling 

Purpose 

To allow employees to self-schedule, a request period must be opened. An Employee 

Request Period defines who can submit a self-scheduling request, when the employee 

can submit a request, and the dates that can be requested to work.  

You need to create a hyperfind to identify the correct employees as locations do not 

work for request periods. 

 

Employee Request 
Periods 

Description 

Name Name of the employee request period. 

Request For Type of request. 

Description Description of the request. 

Employee Query HyperFind query that identifies the employees who can make a request. 

Submission Period Beginning and ending dates and times that define the period during which employees 
can submit requests. 

Request Start and 
Request End 

Beginning and ending dates and times, which define the time period for which 
employees can make requests. 
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Example 

You want to open a time off request period so that employees in can self-schedule for 

the next schedule period. 

First, Build a Hyperfind 

Steps  

1 Select Edit Ad Hoc from the 
Hyperfinds drop-down list on any 
Genie. 

 

 

3 Change the Visibility to Personal.  

Enter a Query Name. 

Select RN in 3M4132 from the 
Primary Job filter. 

Click Add to select the condition. 

Repeat steps 2 through 5 to add 
additional conditions, if necessary. 

 

4 Click Save As.  
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Steps  

5 If you created a Personal query, 
you will be able to view it in the 
Hyperfinds list. 

 

 

Second, Create the Request Period 

Once the hyperfind is created you can use it when creating your self-scheduling request 

period.  

 

Steps 

1 Access a Scheduler.  

2 Select Tools > Manage Employee 
Request Periods.  

The Manage Employee Request 
Periods window displays. 
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Steps 

3 Do one of the following: 

• If an employee request 
period does not exist, 
Add Request Period 
opens automatically. 

• If an employee request 
period exists, select the 
Pencil Icon of the period 
to edit.  

 

4 In the Name field, enter a 
descriptive name. In the 
Description field, enter 
explanatory text about the 
employee request period. 

Note: An employee request period 
must have a unique name. 

 

5 From the Request For drop-down 
list, select the request type. 

6 From the Employee Query drop-
down list, select the hyperfind you 
created for self-scheduling. 

7 In the Submission Period area 
select the following: 

• Specific Start Date and 
Time and End Date and 
Time to identify a specific 
timeframe when 
employees can submit 
requests for self-
scheduling. 

8 In the Request Period area select 
the following: 

• Specific Start Date and 
End Date to identify the 
timeframe that the 
employee can request 
shifts to work (the Next 
Schedule Period). 

9 Click Save. 
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Example 

You want to use an existing request period to open up self-scheduling for the next 

schedule period. 

Steps 

1 Access a Scheduler.  

2 Select Tools > Manage Employee 
Request Periods.  

The Manage Employee Request 
Periods window displays. 

 

3 Select the Pencil Icon of the 
period to edit.  

 

7 In the Submission Period area 
select the following: 

• Specific Start Date and 
Time and End Date and 
Time to identify a specific 
timeframe when 
employees can submit 
requests for self-
scheduling. 

 

8 In the Request Period area select 
the following: 

• Specific Start Date and 
End Date to identify the 
timeframe that the 
employee can request 
shifts to work (the Next 
Schedule Period). 

9 Click Save. 
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Building a Schedule: Evaluate and Update 

Overview 

Purpose 

After the schedule is built by schedule patterns, self-scheduling, or a combination of the 

two, it is then reviewed for schedule rule violations, coverage, and finally balanced.  
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Evaluating Schedule Rule Violations 

Purpose 

Several scheduling policies and guidelines have been incorporated into the application 

as schedule rules. When your schedule violates any of these rules, the application calls 

attention to the violation on the employee row in the Scheduler and also on the Rule 

Violations tab. 

Example 

As you finalize your schedule, you want to check to confirm whether the schedule is 

violating any schedule rules. If so, you want to make adjustments and recheck the rules. 

Steps  

1 Access a Scheduler.  

2 Select the employees and the 
specific time period. 

 

3 Select the Rule Violations tab if 
necessary. 

 

4 Click a row in the Rule Violations 
tab to highlight the applicable 
employee row in the Schedule 
Planner.  

 

 

 

Rule Violation Indicators Description 

Warning  

 

(!) Warning — You can correct or ignore a Warning rule violation. A 
Warning rule violation is saved in the database.  

Informational 

 

(i) Informational — a guideline has been broken, but one with the lowest 
level of severity.  

No Save 

 

(x) No Save — Employee Rule Violation that prevents you from saving the 
schedule. No record of this type of violation is saved. 

 

 

Tip 

An icon appears next to name of the employee with the rule violation. Select the employee’s 
name in the Schedule Planner to highlight his or her name in the Rule Violations tab. Click 
the Name column header to sort the data by the employee name. If an employee has more 
than one rule violation, sorting by the Name column will list the violations together. 

 



 Kronos 8.1 Advanced Scheduler Course Guide v.4 

 

58 © 2019, HFHS University. All rights reserved. 

 

Note 

You do not have to save the schedule to have rule violations display. 

 

 

Caution 

A maximum of 50 rule violations appear in a Schedule Planner. A message in the Rule 
Violations tab tells you if you have reached the limit. To view all rule violations, select a smaller 
group of employees and or a smaller time period. 
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Evaluating Coverage Using Daily Coverage 

Purpose 

You need to evaluate coverage often to determine whether the schedule satisfies your 

core-coverage requirements. The Schedule Planner provides a Daily Coverage view to 

help review coverage. 

You can also evaluate and address coverage using the following Schedule Planner 

tabs: 

• Coverage 

• Metrics 

Example 

You want to validate that you scheduled enough nurses in the department 3M4132. If 

you discover that there are too many or too few employees scheduled, you can modify 

the schedule by adding or deleting shifts to meet the workload plan.  

Steps 

1 Access a Scheduler.  

2 Select the employees and the 
specific time period 

• Select the custom location for department 3M4132 

• Select the next schedule period 

3 Select Daily Coverage. 
 

4 From the View drop-down list, 
select one of the following: 

• Counts 

• Coverage 

 

5 From the Job drop-down list, 
select one of the following: 

• Specific job 

• List All Jobs 

 

6 From the Span drop-down list, 
select one of the following: 

• Specific span 

• View All 

• Day  
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Daily Coverage 
View Option 

Description 

Counts Displays planned and scheduled coverage data numerically in the form of X/Y, where X is 
the number of people scheduled and Y is the number of people planned. If you select Total 
Jobs from the Job drop-down list, a plus (+) sign indicates over-scheduling and a minus (-) 
sign indicates under-scheduling.  

Coverage Displays planned and scheduled coverage data graphically using a shaded bar graph. Tool 
tips display variances between scheduled and planned workloads. 

Counts View Examples Description 

 

This example shows two persons scheduled for the RN job and three people 
planned. You are understaffed by one RN. The color red indicates that you are 
understaffed. 

 

This example shows three people scheduled for the RN job and two people 
planned. You are overstaffed by one RN. The color yellow indicates that you are 
overstaffed.  

 

This example shows three people scheduled for the RN job and three people 
planned. You are scheduled to the planned amount. The color white indicates 
that you are staffed to plan. 

 

Coverage View Examples Description 

 

The number 2 indicates how many people are scheduled. The red bar 
below the white line indicates that the job is understaffed. The information 
in the tool tip indicates that between 7:00AM – 11:00AM you are short by 
one person. 

 

The number 4 indicates how many people are scheduled. The yellow bar 
above the white line indicates that the job is overstaffed.  The information in 
the tool tip indicates that between 7:00AM – 11:00AM you are overstaffed 
by one person.  

 

The number 3 indicates how many people are scheduled. The white line 
with no colored bars indicates that you are scheduled to plan. 
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Viewing/Editing the Workload Planner  

Purpose 

In Scheduler, your staffing requirements are referred to as workload requirements and 

are stored in the Workload Planner.  

Example 

The department census tends to vary from the value used to determine the budgeted 

workload. You can change the planned workload daily.   

 

Steps 

1 Access the Workload Planner. 

 

2 From the Show drop-down list, 
select the specific location. From 
the Time Period drop-down list, 
select the specific time period. 

3 From the Visibility Filter drop-
down list, select one of the 
following: 

• Budget 

• Plan 

• Actual 

• Volume 

• Workload 

4 Edit a number. 
 

5 Select Save. 

 

6 Note the change to your Daily 
Coverage values in the Scheduler. 
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Reviewing the Quick Actions Toolbar 

Purpose 

The Quick Actions Toolbar helps you to streamline schedule tasks and minimize the 

number of mouse clicks to perform a task. 

Example 

When balancing your schedule, you note several employees with over- and under-

minimum scheduled hour amounts. You use the Quick Actions Toolbar to perform 

several shift swaps between employees. 

Steps 

1 Access a Scheduler. 
 

2 Select Quick Actions. 
 

 The Quick Actions Toolbar displays 
on the menu bar. 

 

 

The following table describes the functions available on the Quick Actions Toolbar. 

Name Description 

Assign Click the Assign button, then click an open shift in the schedule, and then click on 
the date cell of the employee that you want to work the shift. 

Unassign Click the Unassign button, and then click the shift of the employees you want to 
remove from a scheduled shift. The shift becomes an open shift for you to fill. 

Shift Transfer Click the Shift Transfer button to view a list of possible jobs you can reallocate 
employees to in your cost center. Select a job from the list, and then click a shift in 
the schedule to perform the reallocation. 

Insert Shift 
Template 

Click the Shift Template button to view a list of shift templates you can apply to 
employees. Select a shift template from the list, and then click a date cell to add 
that shift to an employee’s schedule. 

Comment Click the Comment button to view a list of comments you can apply to employees. 
Select a comment from the list, and then click a shift to add that comment to an 
employee’s schedule. 

Pay Code Click the Pay Code button to view a list of pay codes you can apply to employees. 
Select a pay code from the list, and then click a date cell to add that pay code to an 
employee’s schedule. 

Copy/Paste Click the Copy/Paste button to copy and paste a shift or pay code. The first click 
copies the item; subsequent clicks paste the item. 

Delete Click the Delete button, and then click the shifts or pay codes in the schedule to 
delete them. 

Lock/Unlock Click the Lock/Unlock button and select the shifts to lock/unlock.  
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Name Description 

Swap Click the Swap button, click the shift of the first employee whose shift you want to 
swap, and then click the shift of the second employee. 

Balancing the Schedule 

Purpose 

You should review the schedule to confirm that each employee’s scheduled hours 

match his or her expected weekly hours and that the department hours are in budget. 

If employees’ schedules and department hours for the schedule period do not match 

their expected or required hours, you will need to edit the schedule. Edits can include 

inserting shifts, copying and pasting shifts, deleting shifts, or swapping shifts to balance 

the schedule.  

Inserting a Shift Template 

Purpose 

You can add a shift to an employee’s schedule by entering the start and end times 

directly into the date cells of the Schedule Planner. If the shift times are standard, you 

might have a shift template that you can use. Shift templates define the start and end 

times of standard shifts that employees work regularly. A shift template does not include 

specific days or dates. You can use the Schedule Toolbar to insert a shift template. 

These tools list the shift templates in alphabetical order. 

Example 

An employee agreed to work an additional eight-hour shift on Tuesday beginning at 

3:00 P.M. This is a common shift, so a shift template exists. You can use a shift 

template to insert the shift into the employee’s schedule. 

Steps 

1 Access a Schedule Planner.  

2 Select the employees and the 
specific time period. 

 

3 On the Quick Actions Toolbar, 
click the Insert Shift Template 
button and select a shift template. 

 

4 Click the date cell for the employee 
you will schedule using the shift 
template. 

 

5 (Optional) Click additional date 
cells to add the shift template to 
additional days or employees. 
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Steps 

6 Click Save. 

Note: If you want to make other 
edits to the schedule before 
saving, be sure to click the Insert 
Shift Template button again to 
turn it off. 
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Adding a Shift Using In-Cell Editing 

Purpose 

When there is no shift template for a shift, you can add the shift by entering the shift 

start and end times into the date cell. 

Example 

An employee can work only from 7:00 A.M. to 12:00 P.M. on the first Wednesday of the 

next schedule period. This is not a typical shift, so there is no shift template available to 

add to the schedule. Add the shift to the employee’s schedule using in-cell editing. 

Steps  

1 Access a Scheduler.  

2 Select the employees and the 
specific time period. 

 

3 Click the date cell for the employee 
who will work the shift. 

 

4 Enter the shift start and end times 
separated by a hyphen; for 
example, 7-12. 

Note: The application considers all 
times from 0:00 to11:59 as A.M. 
and all times entered from 12:00 to 
12:59 as P.M. If you are entering 
other times using the 12-hour 
format, be sure to enter the “a” or 
“p” as applicable. 

5 Click Save. 
 

 

 

Tip 

Always look for a shift template to use in place of adding a shift using in-cell editing. When you 
add a shift via in-cell editing, the shift label displays the shift’s actual start and end times. 
Right-click on the shift and select Edit to change its shift label if necessary. Shift labels appear 
in many reports instead of actual start and end times. When shifts are edited or manually 
entered, these reports display shift start times rather than shift labels. 
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Copying and Pasting Shifts 

Purpose 

You can copy and paste shifts and pay code amounts from one day to another, or from 

one employee to another, to speed up the scheduling process. 

Example 

An employee can also work from 7:00 A.M. to 12:00 P.M. on the second Wednesday of 

the next schedule period. Since you added this shift to the first Wednesday of the next 

schedule period, you can use the Schedule Toolbar to Copy and Paste the shift.  

Steps 

1 Access a Scheduler.  

2 Select the employees and the 
specific time period. 

 

3 On the Quick Actions Toolbar, 
click the Copy/Paste button. 

 

4 Click the date cell of the shift or 
pay code you want to copy. 

 

5 Click the date cell into which you 
want to paste the shift or pay code. 

 

6 (Optional) Click additional date 
cells to paste the shift or pay code 
to additional days. 

 

7 Click Save. 

Note: If you want to make other 
edits to the schedule before 
saving, be sure to click the Paste 
button again to turn it off. 

 

 

 

Tip 

To save time, use the copy-and-paste function for more complex shifts that involve transfers to 
jobs and or work rules. 
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Editing a Shift 

Purpose 

You can change the start or end time of a scheduled shift so that you know when the 

employee will be arriving and leaving work. Accurate schedules will allow you to track 

and report on attendance violations. 

Example 

An employee discovers that he can work until 2:00 P.M. on the first Wednesday of the 

next schedule period. You want to edit his shift to change the end time.  

Steps 

1 Access a Schedule Planner.   

2 Highlight the portion of the shift in 
the date cell that you need to 
change. 

 

3 Enter the new time. 

4 Click Save. 
 

 

 

Tip 

When you edit the shift’s start or end time, the shift label displays either the original shift label 
or the shift’s actual start and end times. Right-click on the shift and select Edit to change its 
shift label if necessary. Shift labels appear in many reports instead of actual start and end 
times. When shifts are edited or manually entered, these reports may display the incorrect shift 
label.  
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Deleting a Shift 

Purpose 

When an employee is scheduled for a shift by mistake, you can delete the shift so that it 

does not count towards coverage requirements. Accurate schedules will allow you to 

track and report on attendance violations. 

Example 

Employee is mistakenly scheduled to work a shift on the first Sunday of the next 

schedule period. Right now, you know that you do not need someone else to fill that 

shift. 

Steps 

1 Access a Scheduler.  

2 Select the employees and the 
specific time period. 

 

3 On the Quick Actions Toolbar, 
click the Delete button. 

 

4 Select the shift you want to delete. 
 

5 (Optional) Click additional shifts to 
delete those shifts. 

 

6 Click Save. 

Note: If you want to make other 
edits to the schedule before 
saving, be sure to click the Delete 
button again to turn it off. 

 

 

 

Tip 

You use the Schedule Toolbar’s Delete button to remove a shift when: 

• A shift has been added in error. 

• You do not plan to find a replacement for the shift. 

• The employee will not be paid non-worked time in place of the shift. 
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Applying Pay Code Edits (Using Pay Code Editor) 

Purpose 

In addition to adding pay codes with the Schedule Toolbar you can add them using the 

Pay Code Editor. Use this when the pay code is applied to an unscheduled day, when 

the amount you want to add is less than the shift length, or when you would like to 

define something other than the default logic of the Schedule Toolbar’s pay code button. 

The default logic is to replace the employee’s full shift, create an open shift, and mark 

the employee to be unavailable for 24 hours beginning at the employee’s scheduled 

start time. 

Example 

Employee has jury duty the first Thursday of the next schedule period. You want to add 

the jury duty to the schedule so that the time is tracked and the employee is not 

scheduled to work a shift on that day. You add a pay code edit using the Jury pay code. 

Steps 

1 Access a Scheduler.  

2 Select the employees and the 
specific time period. 

 

3 Right-click the date cell in which 
you want to add a pay code edit, 
and then select Add Pay Code. 

 

 

4 Confirm the date that appears in 
the Effective Date box. 

 

5 From the Pay Code drop-down list, 
select the pay code.  

6 In the Amount field, do one of the 
following: 

• Enter a specific number of 
hours  

• From the drop-down list, 
select a value. 
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Steps 

7 Select Override Shift if the pay 
code amount should replace the 
shift and then select one of the 
following: 

• Whole Shift to replace 
the entire shift with the 
pay code amount. 

• Partial Shift to replace a 
segment of the shift. 

Note: If you select Partial Shift, the 
override begins at the Start Time 
and ends when the Amount is 
reached. 

8 From the Start Time box enter the 
effective time for the non-worked 
hours.  

Note: If the employee has a 
scheduled shift, the shift start time 
appears as default text. 

9 In the Repeat for (D) field, enter 
the number of consecutive days for 
which the pay code applies.  

10 (Optional) Select Create Open 
shift to create an open shift. 

13 Click Apply. 

 

 

 

Business practice 

Pay codes are for Non-Worked time only! 

Some of the common situations in which you will apply a pay code edit are CTO, Funeral, or 
Jury Duty 

 

 

Caution 

When creating open shifts and partial shifts from pay code amounts, split shifts might occur 
and might require editing or deleting. 

 

Tip 

To view your employee’s accrual amounts, right-click the employee’s name and select View 
Accruals. 

The employee’s accrual benefits appear. 

When you are finished reviewing the employee’s accrual information, click OK. 
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Assigning Comments 

Purpose 

Comments provide additional useful information about a shift or a pay code edit.  

Example 

On the first Tuesday of the next schedule period, an employee picked up an additional 

shift that might bring her into overtime. Add the OT Shift comment. 

Steps 

1 Access a Scheduler.  

2 Select the employees and the 
specific time period. 

 

3 On the Quick Actions Toolbar, 
click the Comment button and 
select the comment you want to 
add. 

 

4 Select the shift you want to add the 
comment. 

Note the Comment Indicator. 

View comments with by hovering 
on the shift.  

 

5 (Optional) Click additional shifts to 
add the comment. 

 

6 Click Save. 
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Removing Comments 

Purpose 

Comments entered by mistake can be removed from the system. You can delete a 

comment that you no longer want to appear in the Schedule Planner’s Comments tab or 

the Comments By Employee report because it is no longer valid. 

Example 

You mistakenly added a comment to the wrong employee’s shift. You remove the 

comment so it will no longer appear in the Schedule Planner. 

Deleting comments attached to shifts or pay codes 

Steps 

1 Access a Scheduler.  

2 Select the employees and the 
specific time period. 

 

3 Right click the shift and select Edit. 
 

4 Click the X next to comment you 
want to remove. 

5 Click Apply.  
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 On Your Own 

1. Create and save 4 personal location search queries: 
All jobs at 3M4132 
All jobs at 3M4271 
All jobs at 3M3400 
RNs at all locations  
(pg. 21) 

2. Assign Anna Bliss a reoccurring schedule using a pattern template. You 
choose the template.  
(pg. 27) 

3. Assign Joan Vincent a reoccurring schedule without a pattern template.  
You make up the pattern. 
(pg. 29) 

4. Use Insert Shift Template to schedule Jill Jones for shift on one day 
(pg. 66) 

5. Replace a shift with a Jury Duty Pay Code.  
(pg. 71) 

6. View daily coverage with a 4 hour span for at least 2 different jobs. 
(pg. 62) 

7. Edit a shift for a full day transfer to another cost center.  
(pg. 33) 

8. Edit a shift for a part day transfer to another cost center. 
(pg. 36) 

9. Edit a shift for a full day transfer to a Charge Nurse Work rule.  
(pg. 35) 
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Finalizing the Schedule 

Posting a Schedule 

Purpose 

In Scheduler, posting a schedule saves a copy of the schedule to the database and 

creates an audit trail log entry. It is important to mark a schedule as posted in order to 

track the number of changes made to a schedule after it has been completed. It is also 

important to mark a schedule as posted in order for employees to request shift swaps. 

Example 

You have just completed your schedule for the next schedule period. You post the 

schedule in Workforce Scheduler before making a hard copy to post on the wall. 

Steps 

1 Access a Scheduler. 
 

2 Select the employees and the 
specific time period. 

 

3 Select Tools > Manage Schedule 
Posts, Post 

 

 

4 Click Yes to confirm the posting. 

 
 

5 When the system displays a 
message confirming that the 
schedule has been successfully 
posted, click OK. 

 

 

 

 

Business practice 

Most teams post their schedules two weeks before the start of the next schedule period. 

 

 

Caution 

Schedule sign-up cannot be opened after the department’s schedule has been posted. 
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UnPosting a Schedule 

Purpose 

If you have posted a schedule in error, or note something needs to be changed in a 

posted schedule, you can unpost it. After making the correction(s), post the schedule 

again. Kronos only keeps one copy of a posted schedule, the latest, to compare to how 

the schedule looks now.  

Example 

You have just completed your schedule for the next schedule period. You post the 

schedule in Scheduler before making a hard copy and notice a mistake. 

Steps 

1 Access a Scheduler. 
 

2 Select the employees and the 
specific time period. 

 

3 Select Tools > Manage Schedule 
Posts 

 

 

4 Select 1 or more items from the list 
of posted schedules. Then click 
Unpost.  

 

5 Click Yes to confirm the unposting. 

 
 

6 When the system displays a 
message confirming that the 
schedule has been successfully 
unposted, click OK. Then click 
Done.  
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Generating a Printable Schedule 

Purpose 

Scheduler reports include several schedule formats that can be printed or e-mailed as a 

PDF attachment. Several reports are useful for printing and posting on a wall; the most 

commonly used schedule report is the Location Schedule – Monthly. 

Example 

After posting the schedule electronically, you want to print out a copy that you can post 

on the wall. 

Steps 

1 Do one of the following: 

• To run a schedule for all of your 
employees, select Reports from 
the Related Items pane in the 
default workspace. 

• To run a report for selected 
employees, use the GoTo  
button and select the Reports 
link. 

 

2 On the Select Report tab, click the 
plus (+) sign to display a 
category’s contents and select the 
report. 

 

3 If you did not select employees in 
step 1, from the Show drop-down 
list, select the specific set of 
employees. 

 

4 From the Time Period drop-down 
list, select the specific time period. 
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Steps 

5 From the Schedule drop-down list, 
select Current or Posted. 

Note: A copy of the schedule is 
saved when you post the schedule 
electronically in Workforce 
Scheduler. Select Posted to view 
the schedule as of the date and 
time of the locations last post. 
Select Current to display the 
schedule as it appears in the 
Schedule Planner at the time you 
generate this report. 

6 Click Run Report. 

 

7 On the Check Run Status tab, 
click Refresh Status. 

Note: A refresh icon will display on 
the Status column heading until 
the report status changes to 
Complete. 

 

8 Click View Report. 

Note: The report might appear as a 
separate tab in the browser. 

 

 

 

Tip 

Other reports that are useful as schedules include: 

• Location Schedule – Weekly 

• Location Schedule with Coverage 

• Employee Schedule – Monthly 

• Employee Schedule – Weekly 

• Staffing Sheet – Daily 
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Creating Open Shifts for Open Shift Requests - Zones 

Purpose 

The Schedule Generator automatically creates open shifts needed for coverage. The 

Schedule Generator deletes any open shifts in the Schedule Planner, and then 

calculates how many open shifts are needed by comparing current scheduled shifts to 

workload requirements in the Workload Planner. This option is available only for 

locations using zone sets for coverage.  

To allow employees to submit open shift requests, it is a two-step process. Create open 

shifts using the Schedule Generator and then create an open shift request period. 

Example 

After completing self-scheduling for the upcoming schedule, you want to generate open 

shifts that still need to be filled for the department. Because the department uses zones, 

you use Schedule Generator to create those open shifts, starting with the RN job. 

Steps 

3 Select Engines > Run Schedule 
Generator. 

 

 

 

 

Caution 

The Schedule Generator is used only for locations assigned to zone sets. 

 

 

Tip 

The recommended practice is to run the Schedule Generator for one job at a time. To do this, 
select a single job from the Show drop-down list. 
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Creating Open Shifts for Open Shift Requests- Shift Set 

Purpose 

The Calculate Open Shifts feature automatically creates open shifts needed for 

coverage for departments that use shift sets for coverage. Workforce Scheduler 

calculates how many open shifts are needed for coverage by comparing current 

scheduled shifts to workload requirements in the Workload Planner. 

To allow employees to submit open shift requests, it is a two-step process. Create open 

shifts using the Calculate Open Shifts feature and then create an open shift request 

period. 

Example 

The department wants to generate open shifts. Because the department schedules 

according to shift sets, you can use the Calculate Open Shifts feature. 

Steps 

1 Select Engines > Calculate Open 
Shifts.  

 

 

 

 

 

Caution 

Calculate Open Shifts is used only for locations assigned to shift sets. 
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Managing Open Shift Request Periods 

Purpose 

When you are ready to have your employees request open shifts, you can open the 

open shift request period. Employees can then log on to self-service and request open 

shifts.  

Opening an open shift request period is a two-step process that involves opening the 

visibility period and then managing the request period. 

Example 

With open shifts in the schedule, you want to open the request period for employees.  

Steps 

1 From the Scheduler, Select Tools 
> Manage Employee Request 
Periods. 

 

2 Do one of the following: 

• If an open shift employee 
request period does not 
already exist, click New. 

• If an open shift employee 
request period does exist, 
select the request period 
Edit button (pencil). 

 

3 In the Name field, enter a 
descriptive name. In the 
Description field, enter 
explanatory text about the 
employee request period. 

Note: An employee request period 
must have a unique name. 

 

4 From the Request For drop-down 
list, select the request type. 

5 From the Employee Query drop-
down list, select the specific set of 
employees who will be entering be 
self-scheduling. 

Tip: Select the same employee 
query that you selected in the 
Open Shifts Visibility Editor. 
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Steps 

6 In the Submission Period area, 
select one of the following: 

• Specific Start Date and 
Time and End Date and 
Time to identify a specific 
timeframe when 
employees can submit 
requests. 

• Any Time to allow 
employees to submit 
requests any time without 
restrictions. 

Note: Select the same dates and 
time range entered for the open 
shifts visibility period. 

7 In the Request Period area, select 
one of the following: 

• Specific Start Date and 
End Date to identify the 
timeframe containing the 
open shifts that will be 
visible to employees. 

• Any Date to allow all 
open shifts to be visible to 
employees. 

Note: Select the same date range 
entered in the Open Shifts Visibility 
Editor for open shift period. 

8 Click Save. Then OK 
 

9 Select Tools > Manage Open 
Shifts Visibility Periods. 

 

10 Do one of the following: 

• If no open shifts visibility 
period exists for open shift 
requests, click New. 

• If an open shifts visibility 
period exists for open shift 
requests, select the Edit 
button (pencil). 

. 

 

11 In the Name field, enter a 
descriptive name. In the 
Description field, enter 
explanatory text about the open 
shifts visibility period. 

Note: Open shifts visibility periods 
must have a unique name. 

 

12 From the Employee Query drop-
down list, select the specific set of 
employees you want to include. 
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Steps 

13 In the Open Shifts Visibility 
Locations area, select the 
locations and jobs that will be 
available for employees to select. 

14 In the Visibility Period area, select 
one of the following: 

• Specific Start Date and 
Time and End Date and 
Time to identify the 
timeframe when 
employees can submit 
requests. 

• Any Time to allow 
employees to submit 
requests any time without 
restrictions. 

15 In the Open Shift Period area, 
select one of the following: 

• Specific Start Date and 
End Date to identify the 
timeframe containing the 
open shifts that will be 
visible to employees. 

• Any Date to allow all 
open shifts to be visible to 
employees.  

16 Click Save. 

17 Click OK. 
 

 

Tip 

Instead of creating new open shift employee request periods for each schedule period, edit the 
dates when the schedule period changes. 
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Managing Shift Swap Request Periods 

Purpose 

When you are ready to have your employees request shift swaps, you can open the 

shift swap request period. In addition to managing the shift swap request period the 

schedule must be posted for the time period they are requesting the swap. Employees 

can then log on to self-service and request to swap shifts with their co-workers.  

 

 

Note 

For additional help, reference the steps for in Managing Employee Request Periods for Time-
Off topic located earlier in this guide  
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Handling a Shift Swap or Reassignment Manually 

Purpose 

The Quick Actions Toolbar’s Swap button helps you to make schedule changes quickly, 

including shift swaps and shift reassignments. 

Example 

Two employees inform you that they would like to swap their Monday and Wednesday 

shifts for the first week of the next schedule period. Rather than send them into self-

service to make the swap, you can make it yourself using the Schedule Toolbar. 

Steps 

1 Access a Scheduler.  
 

2 Select the specific set of 
employees and the specific time 
period. 

 

3 In the Quick Actions Toolbar, 
click the Swap button. 

 

4 Select a shift to swap or reassign. 
 

5 Do one of the following: 

• If you want to swap the 
shift, select the other shift 
in the swap. 

• If you want to reassign the 
shift, select the empty 
date cell for the employee 
to which the shift is being 
reassigned. The shift will 
be “swapped” with the 
empty day. 

6 When you are done swapping or 
reassigning shifts, click the Swap 
button to turn it off. 
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Responding to Open Shift and Shift Swap Requests 

Purpose 

The Requests widget summarizes all employees’ requests in one window and provides all supporting 

information to process requests from the same screen. If you approve a request, the change is 

automatically made to the schedule and the employee is notified automatically. If you reject a request, the 

employee is notified automatically.  

Example 

An employee submitted an Open Shift or a Shift Swap request. You want to review and 

respond to the request. 

Steps 

1 Select the Requests Widget tab. 

 

4 From the Request Widget, select 
View All.  

 

 

5 From the Alerts and Notifications 
Widget, select a request. 

 

6 From the Requests widget, select 
a request and click the appropriate 
button to take action. Details of the 
request appear at the bottom of the 
page.  Accruals for the employee 
are also visible at the bottom of the 
page.   
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Assigning an Open Shift Manually 

Purpose 

The Schedule Toolbar’s Assign button helps you quickly assign an open shift to an 

employee. 

Example 

An employee can fill one of the open shifts in your schedule. 

Steps 

1 Access a Schedule Planner.  

2 From the Show drop-down list, 
select the specific set of 
employees. From the Time Period 
drop-down list, select the specific 
time period. 

 

3 In the Quick Actions Toolbar, 
click the Assign button. 

 

4 Select the open shift to be assigned. 
 

5 Select the date cell for the 
employee to whom you want to 
assign the shift. 

6 (Optional) Repeat steps 3—4 for 
additional open shifts you want to 
assign. 

 

7 When you are done assigning 
open shifts, click the Assign button 
again to turn it off. 

 

 

 

Caution 

If you add a shift to an employee’s schedule by inserting a shift template, using in-cell editing or 
copying and pasting, then you will need to delete the open shift. A recommended practice is to 
always assign the open shift with the Quick Actions Toolbar, which will assign it to the 
employee and remove the open shift from the schedule. 
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Call Offs and Shift Replacements 

Entering Call Offs 

When an employee calls in for their shift, the missed time must be accounted for in the 

schedule. You can add the applicable time via a pay code. Hours entered into the 

schedule will flow to the timecard to be paid accordingly. 

 

 

Note 

For additional help, reference the steps for in Replacing a Shift with a Pay Code Edit task 
located earlier in this guide  

 

 

Using the Staffing Assistant to Find Shift Candidates 

Purpose 

The Call List is your primary tool for identifying employees to potentially fill openings in 

your schedule. The list displays candidates to fill an open shift, sorted according to 

employees’ worthiness to fill the shift. Employees who are not worthy candidates are not 

listed.  

Example 

You still have openings for the Day shift tomorrow. You can select each open shift and 

use the Call List to identify candidates that you can call to offer the shifts. 

Steps 

1 Access a Schedule Planner. 
 

2 From the Show drop-down list, 
select the specific set of 
employees. From the Time Period 
drop-down list, select the specific 
time period. 

 

3 Select the Staffing Assistant tab. 
 

4 Select an open shift from the list. 
 

5 From the Sorting and Matching 
Procedure drop-down list, select 
the appropriate procedure. 

6 Click Load. 
7 To assign an employee to the open 

shift, select the Assign button for 
that person. 
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Sorting and Matching 
Procedure 

Description 

01 – Primary Job, Not Working Open shift candidates are determined by staff skills, primary job only, 
available, not scheduled for the day, allow overtime. 

02 – Job Transfer, Not Working Open shift candidates are determined by staff skills and weekly scheduled 
hours, JTS, available, not scheduled for the day, allow overtime. 

03 – Primary Job, Partially Available Open shift candidates are determined by staff skill, weekly scheduled 
hours, primary job, already scheduled, allow overtime. 

04 - Job Transfer, Partially Available Open shift candidates are determined by staff skills, weekly scheduled 
hours, JTS, already scheduled, allow overtime, allow overtime. 

 

 

 

Business practice 

Select Sorting and Matching procedures in numeric order to choose the best match using the 
pre-defined rules.  
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Reports 

Staffing Reports 

Purpose 

There are several staffing reports available in Workforce Scheduler. These reports can 

help you make scheduling decisions, identify and track issues, and evaluate your 

scheduling success. 

 

Tip 

You can generate any report using the same process described in a previous report topic. 

Note that the options available under Set Options will be unique to each report (and some 

reports have no options). 

 

Other common reports 

Report Description 

Single Zone - HFHS This report shows multiple departments for a single schedule zone, and shows 
actual staffing levels as compared to planned, scheduled, target and budgeted 
staffing levels for that department.  

Customized Single Zone report in landscape format, Removed Open shift from 
existing report 

Staffing Sheet – Daily - HFHS Customized Report by HFHS to meet daily staffing needs. 

All Zone This report shows a single department for multiple schedule zones, and shows 
actual staffing levels as compared to planned, scheduled, target and budgeted 
staffing levels for that department. 

Staffing by Zone Displays the scheduled employees by zone for one or more locations or dates. 
Provides a space for writing comments or patient assignments. The end of the 
report lists the employees with time pay codes. 

Staffing Efficiency Measures how effectively the staffing plan was executed.  

Staffing Sheet - Weekly Shows weekly staffing for selected locations. This report lists the schedule and 
variance from the plan within each shift or schedule zone. You can use this report 
to determine if the schedule meets the planned coverage requirements. 

On Call - HFHS Provides a list of employees who are scheduled as On Call. This report includes a 
comments area for any handwritten notes about the shift. 

Customized On Call report with Shift Label 

Open Shifts – Monthly Displays all open shifts for the month for the selected location. 

Float Displays all float activity for one or more locations and dates. The report only 
shows transfer activity for the selected locations. It summarizes the In, Out, and 
Net hours for each location. 

Comments by Location Lists, by location, the comments associated with shifts or pay code edits. 

Comments by Employee Lists, by employee, the comments associated with shifts or pay code edits.  

Staffing Efficiency Measures how effectively the staffing plan was executed. This report is typically 
used for TJC (The Joint Commission) inspections. 
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Report Description 

Actual vs. Schedule  
by Job 

Displays a summary of individual employees and groups actual, scheduled, and 
projected hours for the selected period, sorted by job. 

Coverage Weekly Shows scheduled coverage, with variance from the staffing plan, by location for 
each job and shift or schedule zone. Can be used to manage coverage by location, 
job, or time period. It displays 7 days per page and prints on 8.5x11 paper. 

Location Schedule  
with Coverage 

Combines data from the Location Schedule and coverage reports. Displays 
schedule and staffing coverage numbers for a location regardless of primary job. 
This report groups shifts by location, zone, and then by primary job. 

Holiday Credits Displays holiday credits issued or denied for each employee. 

 

  



Kronos 8.1 Advanced Scheduler Course Guide v.4   

 

 © 2019, HFHS University. All rights reserved. 93 

Locking Shifts and Days 

Purpose 

Locking a day for an employee prevents anyone from modifying the scheduled contents 

of that day for the employee, including both the shifts and pay code edits. 

Locking Days Example 

An employee is not required to work the upcoming holiday. You lock the day to ensure 

that the employee is not accidentally scheduled for a shift that day. 

Locking Shifts Example 

Because of an employee’s ACLS skill, his services are needed in ICU on the first 

Monday of the next schedule period. You lock his Monday shift to ensure that the 

employee is not accidentally floated elsewhere. 

Steps 

1 Access a Schedule Planner. 
 

2 From the Show drop-down list, select 
the specific set of employees. From the 
Time Period drop-down list, select the 
specific time period. 

 

3 Do one of the following:  

• To select one employee, click the 
employee’s name. 

• To select multiple employees, hold the 
Ctrl key and click all applicable 
employees’ name. 

 

4 Right click and select Lock 

5 From the Start Date drop-down 
calendar, select the first date to 
lock.  

 

6 From the End Date drop-down 
calendar, select the last date to 
lock. 

7 Click OK and confirm the locked 
shifts/days in the Schedule 
Planner. 

8 Click Save. 
 

 

 

Tip 

If you need to lock only a single shift, you can right-click the shift and select Lock. Or, using 
the Schedule Toolbar, you can select the Lock button and then select the specific shift. 
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Tip 

To unlock shifts, use Actions > Unlock. The Unlock list provides the same options as the 
Lock list. Or, using the Schedule Toolbar, select the Unlock button and then select the locked 
shift. 
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Assigning Notes 

Purpose 

When you add a comment to shift or pay code you can also add a note. A note is free-

form text to provide additional details. 

Example 

On the first Tuesday of the next schedule period, an employee picked up an additional 

shift that might bring her into overtime. Add the OT Shift comment and an applicable 

note to her Tuesday shift. 

Steps 

1 Access a Schedule Planner.  

2 From the Show drop-down list, 
select the specific set of 
employees. From the Time Period 
drop-down list, select the specific 
time period. 

 

3 Click the shift that requires a 
comment and select Shift > Edit. 

 

4 From the Comments drop-down 
list, select the applicable comment.  

 

5 (Optional) Repeat step 4 for 
additional comments. 

 

6 In the Notes section, click Add. 

Tip: If the Add button is not active 
(blue), select a comment to 
activate it. 

 

7 In the Note field, enter free-form 
text. 

 

8 Click OK. 

9 Click OK. 

10 Click Save.  
 

11 A comment icon appears in the 
date cell. Click on the Comments 
tab to view the comment(s) and 
note(s). 
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Removing Notes 

Purpose 

If you add a note and then need to delete, you will need to edit the shift or pay code. 

Example 

You mistakenly added a note to the wrong employee’s shift. You remove the note so it 

will no longer appear in the Schedule Planner. 

Deleting a note attached to shifts 

Steps 

1 Access a Schedule Planner. 
 

2 From the Show drop-down list, 
select the specific set of 
employees. From the Time Period 
drop-down list, select the specific 
time period. 

5 Click the shift and then select Shift 
> Edit.  

 

6 Select Delete in the Notes section 
and then click Yes to confirm the 
deletion. 

 

7 Click OK.  

8 Click Save.  
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Transferring to an On Call Work Rule 

There are special considerations when transferring an employee to an On Call work rule 

and they are also scheduled for regular work ON THE SAME DAY.  

 

Employee Scheduled for Regular BEFORE On Call 

When an employee is scheduled for Regular time BEFORE their On Call time on the 

same day, you must create TWO separate shifts on the same day. This results in TWO 

separate rows in your scheduler.  

Notice how Monday, 4/07 in the screen shot below has the Regular time on one row 

and the On Call time in a SEPARATE row. Also notice that the Regular time is BEFORE 

the On Call the time.  

 

 

Employee Scheduled for Regular AFTER On Call 

When an employee is scheduled for Regular time AFTER their On Call time on the 

same day, you must create ONE shift for that day that includes both the On Call time 

and the Regular time. This results in ONE row in your scheduler.  

Notice how Tuesday, 4/08 in the screen shot below has both On Call time and the 

Regular time included in a single shift. Also notice that the Regular time is AFTER the 

On Call time.  
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